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25.03. mSupply client / server installation
part 3

~  These steps need to be carried out after completing
/1 the steps described in:

£22-5 20.01 mSupply client/server installation part 1
20.02 mSupply client/server installation part 2

Obtaining a data file

If you are setting up a sync site for a synced system, then you will need to:

1. Generate the XML file for the sync site from the central server - refer 29.04. Sync Site Export
2. If creating a single-user sync site:
1. Transfer the XML file to the sync site. The Dropbox that you configured in Install Dropbox
is handy for this purpose.
2. Create the datafile from this XML file through 29.05. Sync Site Import.
3. If creating a server sync site:
1. Create the datafile from this XML file through 29.05. Sync Site Import. This could be done
on the server, but is normally easier to do 'locally'. Make sure you are NOT using a
version of mSupply more recent than that being installed on the server.
2. Transfer the datafile to the sync site. The Dropbox that you configured in Install Dropbox
is handy for this purpose.

Installing mSupply Server software
If you are upgrading from a previous version...

If you are upgrading from a previous version of mSupply, first perform a data backup:

e With mSupply server open as an application click on File> Backup.... This will generate a
backup file of your current data with file extension .4bk.

e Copy this file to at least one safe place, e.g. USB drive, a cloud service such as Dropbox.

e Continue only when the .4bk file has completed transfer to the remote location.

Moving from pre v3.50?

' There was a major upgrade of mSupply's internal structure in
v3.50. If you are upgrading from a pre v3.50 installation of

mSupply, Sustainable Solutions will need to convert your
data so that it can be read by mSupply versions after v3.50.
This conversion process is provided free of charge.

mSupply documentation wiki - https://docs.msupply.org.nz/


https://docs.msupply.org.nz/admin:server_installation
https://docs.msupply.org.nz/admin:server_installation_2
https://docs.msupply.org.nz/synchronisation:site_export
https://docs.msupply.org.nz/admin:server_installation_2#install_dropbox
https://docs.msupply.org.nz/synchronisation:site_import
https://docs.msupply.org.nz/synchronisation:site_import
https://docs.msupply.org.nz/admin:server_installation_2#install_dropbox

Last update: 2023/06/02 00:05 admin:server_installation_3 https://docs.msupply.org.nz/admin:server _installation_3?rev=1685664337

Obtain and run the mSupply Server installer

The client/server version of mSupply has two installers:

e One installer, with the word Server in the title, is used
to install the mSupply Server software on a single
server computer.

@ e The other installer, with the word Client in the title,

is used to install the mSupply Client software on as
many computers as you wish including on the server
computer. You will be limited in how many clients can
connect at any one time by the server licence you
have purchased.

/. You must be logged on as Administrator to install mSupply
:"‘ + . Server with the correct permissions. Please consult your IT
support staff if you require assistance to achieve this.

Once you have obtained the mSupply Server installer file, double click it to install. Here is what the
mSupply server installation window should look like:

¥, msupphy Server Setup X

Installation Folder l
‘Where would pou ke moupply Server to be installed?

The software will be nstalled in the folder ksted below. To select a different location, ether type in a
new path, or click Change to browse for an esisting folder.

Install mSupply Server to;

C:\Program Files\mSupplyhmSupply Server Change...

Space required: £41.1 ME
Cpace available on selected drive: 88066 GE

£ Back Mest » Cancel

e You may be asked by the operating system whether 'you want to allow this app to make
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changes to your device?'. Click Yes

e At the mSupply Server Setup Welcome screen, click Next

e To proceed with the installation, you will need to click on the 'l agree to the terms of this license
agreement' radio button and click Next

¢ Unless you have good reason to do otherwise, don't change the installation folder, and click
Next

» Unless you have good reason to do otherwise, don't change the Shortcut folder, and click Next

e At the Ready to Install window, click Next

o After some time (minutes!) you will be shown the Installation Successful window. Click
Finish

What is installed where:

We strongly recommend you do not change the default installation directories, which are as follows:

e mSupply Server: C:\Program files\mSupply\mSupply Server
e mSupply Client (see Installing mSupply Client below): C:\mSupply Client

mSupply Server installer also installs the following files and folders:

3 == = |

@k_/-vl v Carmputer » Local Disk (C5 » Program Files » mSupply » mSupply Sercer » reparts » v | #4 || Search reports B2

File Edit ‘View Tool: Help

Organize - Include in library = Share with Mew folder - [ 1)
MSBuild 4 Mame ' Date madified Type 1
4 [ mlupply
wn
a misupphy Server _
' [5_Store

4d Extension: .

N Detrve_rermote_sme_sibe.pproreP

Camponents

a backorder_surnmans 4R A

Mateee Cornponents
F B backorder_summmany_groupby_narme.dgre

Plugins
g = bed_occupancy_rate.dgr 1 a
reports —
B bet_bonus_by_cust_tot40R
Resources

= bet_bonus_by_customer 4R
& bet_discount QR

= bet_donstion 40R

ﬁ pet_donation_by_name, £0R

server Database
UpgradedDClient

Heell Connect

Starting the Server for the first time

e There is no point in carrying out the following steps
unless you are ready to create a new mSupply data
file, or you have one to load.

e |f this is a satellite site on a synced system, you should
have one to load - refer Obtaining a data file.
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Run mSupply Server

We need to run mSupply Server as an application until all configuration is completed.
:+ . Don't run as a Service now as some configuration functionality is not enabled when run

as Service.

Sometime it has been useful to allow the mSupply.exe to run as Administrator by default. This gives
the application the right to modify data in folders that may have been unknowingly restricted by

operating system.

View the mSupply.exe file inside the mSupply installation folder. View properties then Compatibility
tab and set the file to always Run this program as an administrator. View the image below for better

guidance.

Mame Date rodified Type
Components 1 W20 i Filg folder
Licenses 202 File &

Watnve Compaonents .
P .+ mSupply.exe Properties

Plugins
reports (Germral  Compatibdity Security Defals Previous Versions
Resources I this pragram isnl warking comectly on this versian of Windows
Server Database try unring the: compatibility troubleshooter
UpgradedDClent | Aun compatibiity roubleshooter ]
& mSupply.exe How do | chooss compatibilty ssling: manualy?

40 Compaler.dll
4Dlibzip.dl Lompatilty mace

3 [ Run this program in compatibdity made for:
ADMsg.dil

| aDSLLAN Vindews B

| ADglib.dil
codeeditor.dll Sﬂ_mgs )

:DB—"D-&‘I“ Reduced colar mode
Graphics.dil Bbit (256 color

| GULdN Furn in 540 x 480 screen reaohution
hitpserver.dil [ ] Dizable display scaling on high DF| sstlings

| il [+ Run this program as an adminisirator
Kernsl.dil

1 KemellPC.dil
languagesynta.dil
LDAPC ormponent.dll Change settings for 2l users
I|h:zy32.:!||
libhunsgelldll QK Cancal Poply

We need to run the mSupply Server software as Administrator.

Find the mSupply Server executable (C:\Program files\mSupply\mSupply
Server\mSupply.exe), right-click on it and select Run as administrator

19,650 KB
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You will then be presented with the following dialogue box:

Open
Open file location

Run as administrator I

Troubleshoot compatibility
Pin to Start

Upload to MEGA (1 file)
Edit with Motegad++

Scan with F-PROT Antivirus

Pin to Taskbar
Send to

Cut

Copy

Create shortout

Delete

Rename

Properties

e Y

Mo data file vas found for the database "m3upply.4DC". Do you want to
open an existing data file or to create a new data file?

A 40 database needs this file to store its data,

Cancel ] [

g [ Open ]

Click Create to create a new data file or Open to choose an existing data file. The below image

shows an existing data file.
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& Select a 4D Data File ==

P |
@-ulvl « My Documents » mSupply_data » server_data[0010] » data_file » v|+y|| Seqrch dota_file jol

Organize « Mew folder ==~ [ ﬂ'

mSupply *  Documents library

) Arrange by:  Folder =
data_file

mupply Server Migeria
a mupply_data

Auins server 110321 Marne
axios_data temporary files
Axios_foundation E server_data,ddd
Kiribati
Kiribati |atest data
nims 0L
MIE_mSupply_data[0078]
nrms_wl2_data
nrh datafile

4 server_data[0010]

4 data_file

m

ernporary files

Preferences - |74 m b

File name: » |40 DataFile (“4dd*data) |

[ Open l | Cancel |

Since Windows version 1803 and following, there can be
issues with permissions to access folders located in
individual user folders such as under My Documents.
Therefore, it is now highly recommended to save your data
file in the folder: C:\ServerName mSupply data
replacing ServerName with the mSupply server (site) name,
eg. C:\Hagen AMS mSupply data.

—

You may get a question from the Windows Firewall requesting permission for mSupply to
communicate through the Firewall.
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@ Windows Security Alert >

@ Windows Firewall has blocked some features of this app

Windows Firewall has blocked some Features of 4D Server on all public and private networks,

g— Mame: 40
&
Publisher: 40
Path: Cihprogram Files {x86)\msupphmsupply server
Imsupply, exe

Allow 40 Server ko communicate on these nebworks:

Private networks, such as my home or wark networlk,

[ ]Public netwarks, such as thase in airports and coffee shaps {not recommended
because these networks often have litkle or no security)

What are the risks of allowing an apo throuah a Firewall?

D llow access Cancel

Allow mSupply to communicate on both private and public networks.

If the above steps have succeeded, you should see the 4D Server Administration window:

& mSupply - [mSupply4DC - 4D Server Administration] = | o

File Edit Window Help = =S

IElr-.-1-:ur'|itu:ur' 'm‘ Us (0] 'r o (17 ;t Maintenance %.ﬂ.pplicatic

1

1mn

System Information Hard drive Me mory

Machine: SUSSOL-PC 233 GB 3.23GB

System: Windows Seven Business Edition, 32-bi

Processor: Intel(R] Atom(Th4) CPU D510 @ 1.66GHz
IP Address: 192.168.3.220

Application information

Wersion: 13.2

Maximum connections

Application Server: 4

Data: 917 ME || Used by 4D: 117 MBE ||
$QL Server: Mone Others: 32 GB [} Others: 847 MB [}
Wieb Server: Unlimited Free: 140 GB ] Free: 2.29 GB ]
SOLP Server: Unlimited

License Processors Network
Mame: - .
Used by 4D 2% Received: 4 kE/fs
Licensed ta: - Total: 2% Sent: 52§ Bis

mSupply documentation wiki - https://docs.msupply.org.nz/



Last update: 2023/06/02 00:05 admin:server_installation_3 https://docs.msupply.org.nz/admin:server _installation_3?rev=1685664337

Configure backups

e Edit > Settings > User settings for Data file > Backup tab
o Scheduler: Set Automatic Backup: to Every day, at 20:00 or later, as long as it is a
time when work is likely to be finished. It will have to be set earlier, say 16: 00 if the
server is switched off of an evening.
o Configuration:
» Content:

e tick Data File

e untick Structure File

e untick User Structure File

e Delete all 'Attachments' except the .4DIndx file.

e Add the journal (journal) files to the backup. The Journal file cannot be
selected until you have configured it under Log Management below, and
run the backup once, which you can do once the backup settings have been
configured. Once these have been configured, the backup contents should
look something like this:

Scheduler Configuration Backup & Restore

Content

Data
[ structure
[CJUser Structure (only for binary database)

Attachments: Jilw “i4.4DlIndx

") 1journal” in volume "D:"

Delete Add folder... Add file...

e |f this server uses the Dashboard, then add the dashboard configuration files
(normally C:\Progran Files\mSupply Dashboard\data\grafana.db
and C:\Program Files\mSupply Dashboard\conf\custom.ini) to the
backup - see here (noting that the journal file hasn't been added yet!):

Content

[ Data File
[ Structure File

[ User Structure File

Attachments: "grafana.db" in volume "C:"
"custom.ini” in velume "C:"
S data.40ndx

Delete Add folder... Add file...

e Backup File Destination Folder
o If on physical hardware, this should be a separate physical disk (e.qg.
D:\mSupply backups).
o If on a virtual machine it is preferable to store the backups on a separate virtual disk.
e Log Management: Set .journal to the same parent folder as the backups.

If a location of the log file is already specified, and you want
v to change it, you need to untick the “Use Log” tick-box and
- then when you re-tick it you will be prompted for a new
location.
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e Backup & Restore
o General settings
= tick Keep only last 30 backup files (dependent on disk storage space).
= tick Backup only if the data file has been modified
= Delete oldest backup file after backup
= |f backup fails: select Retry after 30 Seconds
= tick Cancel the operation after 5 attempts.
o Archive
= Segment Size (Mb): None
= Compression Rate: Compact
= Interlacing Rate: None
» Redundancy Rate: None
e Automatic Restore
o tick Restore last backup if database is damaged
o tick Integrate last log if database is incomplete
e Click OK

You may see the following dialogue box:

The log file will be activated after the next backup of the data file, Do you
wiant to start the backup automatically?

[.-

Cancel

e Click OK to create the first backup.

Configure cache

Edit > Database Settings > User settings for Data file
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&> mSupply

Fie  Edit Wndow Help

O »

Saraar Adiminigtratsn
— =

| " . i {00} Maintenance  Apphcat

Show Clipboard

Preferences.., Chrls,
Database Settngs Shruciune Settings...
i User Settings...

WUser Settings for Data file...

System Infoamation

Hard drive
Machime: PNGDT 50 GE

System: Windows 10 Senver or greater, &d-bit

Frocesion Intel Core Procesiorn (Broacwaell)

IP Address: Any

Application information
Wersson: 17 build 17220509 #d-bit
Valumi Shadow Copy: Up and runming

Maximum connections

Dtz EGE
App. Serven 1500 Used) Hhers 2608
S0L Server; Hone Free MGE
Wil Sareen Linkimited
SOWF Serien Hone
Processars
L= Used by 40: 1%

Select Database and then set up the cache memory.

Tick Calculation of adaptive cache

Memory
24 GB

Used by 4D 173 MB
Others: 2.4 GB
Free 214368

Hetwork

Received: & kBJ/s

e Memory to be reserved for other applications and for the system: = 512 MB (default?)

e Percentage of the available memory used for cache = 100%. According to the 4D v16.5
Database/Memory page, 'Percentage of the available memory used for the cache = 100% since
there is only one 4D Server application.' If other applications running on the server need

additional RAM, it should be added to the figure above.

e Minimum size = 1,000 MB (default?)

e Maximum size = can be set to any number, including greater than available RAM. If this number
is greater than the available RAM, 4D will adapt the size of the cache according to the actual

available RAM,
e Flush Cache every: 2 Minutes

https://docs.msupply.org.nz/
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L

miupply - User Settings for Data file

L

| g @ APF| WEE| sOL| |P‘HI’
Y™ Interface Database Backup Client-server  Web 5QL FHP
Mermony

Database Cache Settings

[ Calculation of adaptive cache

Mermory to be reserved for ather applications and for the system: 512| MB
Percentage of available memory used for cache: 100 %
Minimurm Size: 1000 MEB

Mlaximum Size! 16000, MB

Physical Memory: 16383 MB
Current Cache: 2500 MB
Cache on Restart: 15871 MB

Flush Cache every 2| Minutes -

e Click OK

e Exit 4D Server Administration window.

e Check that the settings.4DSettings file has been created in the
<DataFolder>/Settings folder

Setting the server software to run as a service

The server should now be set to start automatically when the machine is turned on. This can be
accomplished by setting the server to run as a service. Choose File > Register Current Database
as Service.

If the Register Current Database as Service option is
|\ greyed out, you are probably not running the mSupply
&% Server as Administrator. You need to quit the server and run
as Administrator.
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r

& msupply

ﬂ]E Edit ‘Window Help
Mewy 3
Dper... Ctrl+0
Dpen Recent *
Close Database... Ctrl + Shift+ AL+l
Clase Window Crl +uf
Close & Windows Chrl + 2t -+

Register Current Database as Service
Unregister Current Database

Unregister all Server Sepvices

Flush Data Buffers Ctrl +3hift+Alt+ 35
Backup...
Restore...
Quit Ctrl+0)

Once you have registered the Current Database as Service, Quit the 4D by clicking the close box on
the top right (or choose File > Quit from the menus). You will then be shown a disconnect window
something like this (you can select Disconnect all clients and quit if no users are currently active):

40 Server

(O Disconnect from Server in: 10 min.
() Wait for all clients to disconnect.

() Wait for active clients to disconnect.

qQrore '|"l':|:'| ng clients)

Message:

(® Disconnect all clients and quit.

Cancel QoK

Pin Services to the taskbar

It is important to be able to quickly observe the status of the 4D / mSupply Service. Therefore, we pin
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Services to the taskbar:

¢ Click Windows icon

e Type Services

¢ Right-click the Services Desktop App
e Select Pin to taskbar

Configure mSupply Service settings

Click on Services in the task bar. You will be shown a window like this.

4 Services Ol =|
| agion vew ||+ = |[Em|EFRB| @] > = 1 =
Tree I Mame £ | Descripkion | Skatus | Startup Tvpe | Log On As | -

% Services (Local) 4D Server: mSupply Manual LacalSysten
%.ﬁ.lerter Matifies sel... Mariual LocalSystem
%npplicatiun Mamage... Providess... Maral LocalSyskemn
%Clipﬁnnk Supporks C,., Manual LocalSystem
%CO[\H Event System  Provides a...  Started Manual LocalSystem
%Cnmputer Brawser Maintains a... Started Aukormatic LocalSystem
%DHCP Clignk Manages n... Starked Aukarnatic LocalSystem
%Distributed Link Tra... Sends notif... Starked Aukornatic LocalSystem o
%Distributed Transac... Coordinate... Starbed Mariual LocalSystem
%DNS Client Resolves a,,.  Started Aukormnatic Local3ystem
%Event Log Logs event,,, Starked Aukomatic LocalSystem
%Fax Service Helps vou ... Manual LocalSystem
%Indexing Service Manual LocalSystem
%Internet Conneckio..,  Providesn... Manual LocalSystern
%IPSEC Palicy fsgent Manages I...  Started Aukomatic LocalSystem
% Logical Disk Manager  Logical Disk..,  Started Aukomatic LocalTystem
%Lngical Disk Manage... Administrat... Maral LocalSwstem
%Messenger Sends and ... Started Aukomatic Localaystem
%Net Logaon Supporks o, Manual LocalSystem
%Netrﬂeeting Remote.., Allows adt, ., Manual LocalSystem
%Netwnrk Connections  Manages o...  Starked rlaral Local5wstemn ﬂ

Double-click on 4DServer: mSupply - fortunately it is usually the first item in the list!

You will be shown the 4DServer: mSupply service properties window. Change the Startup type in
the drop-down list to automatic (Delayed start).
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4D Server: m5upply Properties (Local Computer)

General |ogOn Recovery Dependencies

Service name: 4D5 msupply

Digplay name: 4D Server: mSupphy

Description:

Path to executable:
C:%Program Files («36)'mSupplymSupply Server'mSupply exe s "C:\F‘mg%

Startup type: Automatic (Delayed Start) ~

Automatic (Dela
Automatic
Manual
Dizabled

Service status:  ROMMING

Start Pause Resume

You can specify the start parameters that apply when you start the service
from here.

Start parareters:

ok | cancel | feply

it

Log on as administrator account

With mSupply 3.85+ on Windows Server 2012+ and Windows 10 1803+ the service has had to be

assigned to “Log On” to an administrator account for mSupply service to start:

4D Server: mSupply Mamy 4D Server: mSupply Properties (Local Computer) X g

Stop the service g“ General LogOn  Racovery Dependencies 2

Restart the service :

T ‘ﬂ: Log on &s: =
éi () Local System acoount :’:

- Allaw senvice o inberact with desktop

'-L‘-}P- ]
e ) () This sccount ‘Administrator | Browee... ct
ﬁn Paszwarnd. -!"'ll'I'll'Ii!lliill | Z:
lﬂ: Coonfirm passwand- -!iIil"ll"i!l-iil- | ]
ﬂﬁ ]
A <
e P
g =
ki i
) e
-ﬁ\:!; ol
Qic e
i+ e c
Gc o
&< e
ac ok [ coee | [ [
'F"I FNM L aslior ChTla-d- s Callad bn D Diinmime B ch o i [
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Configure the computer to restart if the mSupply service does not start

e Sometimes, for some reason, including, for example, after certain Windows OS updates, the
mSupply Service will not automatically start, even though you have configured it to.

e To guard against this, it may be worth configuring the computer to restart if the mSupply
service has not started after a LONG delay, say 120 minutes. This is done on the Recovery tab:

File Action View Help

ks |FE = HmE >0
Services (Local) ' Services (Local) C - \
4D Server: mSupply General LogOn Recovery Dependencies Status Start A
frw to date. If thi iceis .. Aut
5 h i Select the computer's response if this service fails. Help me set up recovery proware up to date 15 semvice s uie
top the service . .
= N actions oftware up to date. If this serviceis ... Man
Restart the service e i
Frt il - Running  Autc
st faiure: Restart the Service ¥ Control validation for the installatio... Man
Second failure: Restart the Service — — S -
Restart Computer Options X
Subsequent failures Restart the Computer
Reset fail count after: 0 days Restart computer after: minutes
Restart service after: 1 minutes
[[] Before restart, send this message to computers on the network:
[[] Enable actions for stops with emors. Restart Computer Options
Run program
Append fail count to end of command line (fail="1 Cancel
is used by Windows Backup to perf... Man

Manually starting the Service

Despite being configured so, the mSupply Service sometimes will not start when the server hardware
starts. The service can be started through the Services:

Services =[O
File Action View Help
e [E Bz B »mnw
"= Services (Local) O Tz (Local)
4D Server: mSupply Mame “ Description Status Startup Type Log On As A
+ 4D Server: mSupply Automatic (D... Local Syste...
E service o ActiveX Installer (AxinstSY) Provides Us... Manual Local Syste... _
o Advanced Monitering Agent Running  Autematic Local Syste... =
i Advanced Monitoring Agen... Add-on ser..  Running  Automatic (D.. Local Syste..
" App Readiness Gets apps re... Manual Local Syste...

Manually stopping the mSupply Server Service

e To manually stop the mSupply Server Service, first make sure clients are not connected, then
double-click the “Services” shortcut you made on the desktop, highlight the 4D Server service,
and click the square “stop” button (looks like a “Stop” button on a media player)

Creating a new data file or choosing a different data file

From this point there should be no need to revisit any of the above procedures to operate mSupply.
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However, if you are testing, or starting a data file for a second organisation, you may wish either to

change the data file mSupply is using or to create a new file.

The mSupply program (the files named “mSupply.4DC” and “mSupply.RSR”) store the path to the last
data file used, and the next time mSupply is started, the previous data file that was open is opened
again unless there is user intervention or the “old” data file has been moved to a new location.

To intervene, hold down the “alt” key as the 4D server starts up.

You will be shown the standard open/save window:

N — 2 x|

Look in: I ) Data

~| e & ok E-

WebFalder

Histary

L
b

ry_precious_data

Ju]

by Documents

I y Com| p Liter

File riamme: Imy_precinus_data

Files of type: |Data File [+ 4dd)

j Open
j Catcel |

To create a new data file, click the “New” button.

To select an existing data file, navigate to the file's location then click the “Open” button.

Installing mSupply Client

Needed: mSupply Client software of the same version (or relatively recent) as the mSupply Server.

e The mSupply server should run as a service on the
server computer - see above. If any user needs to use

possible, and sometimes necessary) then they should

6 mSupply on the server (not recommended, but

not be running the mSupply Server software. They
should run the mSupply Client software, which should
be made available to all user accounts.
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Obtain and run mSupply Client installer

/= You must be logged on as Administrator to install mSupply
! " Client with the correct permissions. Please consult your IT

'—;‘ -

support staff if you require assistance to achieve this.

e Once you have obtained the mSupply Client installer file, double click it to install.
The mSupply client will be installed in the folder C:\mSupply\mSupply client on your computer.
mSupply client installer also installs the following files and folders:

¢ A shortcut on the Desktop called mSupply client.

¢ A folder called “\4D\Network” in the Windows folder on the startup volume, which contains
network component files that need to be present for 4D to communicate over a TCP (and other
types of) network(s).

* No reports are installed on 4D client. Each time 4D
client connects to the Server, reports that have been
added or modified on the server are automatically
copied to the client.

< e Installers have been set up to overwrite existing files,
@ so reinstalling the software will restore any potentially
corrupted files to their original state. The installer will
not overwrite your data files, unless you have been
unwise enough to name your data file “example data”
=

-

and put it in the “example data” folder

For convenience, pin the mSupply client desktop shortcut to the taskbar.

If any other Windows users will use this computer to access
mSupply, it is worth copying the mSupply client desktop
shortcut to the C:\Users\Public\Desktop folder. This
will place the shortcut on the desktop of each user. Each
user will need to pin this shortcut from their desktop to the
taskbar.

g The C:\Users\Public\Desktop folder is normally a
hidden folder. You will likely need to make it visible).

Additionally, if this computer is primarily used for running
mSupply, then it is worth copying the mSupply client
desktop shortcut to the Startup folder. The actual folder
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o0
name changes with Windows version = so here are
_ instructions: How to Add Programs, Files, and Folders to
£ System Startup in Windows.

Starting the mSupply Client

Once the installation is completed, double-click the “start mSupply Client” shortcut on your desktop. A
window something like this should appear:

B " Connection to 40 Sencer b 4

u Welcome to 4D

Recent Available Custom

Servers

msupply BULLETTRAIN

[[] Display this dislog at nest startup

Cancel

The window lists available mSupply servers on your network (there should be only one!) Click on the
server you wish to connect to.

e Once you have connected successfully, the mSupply
Client 'remembers' which Server you last connected to
and stores this in the Recent tab. Whenever you run
the mSupply Client, it will automatically connect to
that server.
. e |f, mSupply Client cannot connect to the mSupply
© Server, this window will pop up showing the Recent
tab. You can try choosing the server there.
e If, for some reason, network settings have been
changed and you cannot connect from the Recent tab,
remember to look at the TCP/IP tab as well.
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Clicking the “OK” button will take you to the mSupply password entry window. For new data files, the
password is userl for the first user in the list. Click on the first user, then enter the password and

click OK
Forcing mSupply Client to re-sync files from the server

Occasionally the mSupply client may fail to connect with the server for un-known reasons. Errors such
as the “This database has not been compiled for 64-bit processors” has been encountered and can be
fixed in the following manner. Please read on.

This database has not been compiled for 64-bit
ProCessors.

oK

Sometimes simply forcing the mSupply client to retrieves all setup files from the server may just fix
things.

To do this Double click on the mSupply Client icon and hold the “Alt” (option on MAC) key. You should
see such a window open.

9 Welcome to 4D

Recent Avalable |Custom

Senvers

I’l"gu:pl:!r' CF [[5 ]

] Display this dialog at next startup

Cancel Ok

On the above window select the server and click the custom tab.
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B Connection to 40 Server

0 Welcome to 40

Recent Available Lustom

MNarme and Address of a published 4D Server:

Database Mame: |mSupply

EX Gorounmng

Wetwork Address: B k19813

£ BOrouAting. company. oo
or: 192121, 122 123:8858
or: [2007:0db8:850.3:0000:0000: 8o 2e:0370: T324]: 19813

] Force the update of the local rescurces |

[] Display this dialog at net startup

Cancel

}f

On the above window check the Force update of local resources checkbox and click the OK button.

This will force the mSupply client to get the resources from the server and past issue may now be

resolved.

Close mSupply and restart normally without the “Alt” key and mSupply client should be able to
connect to the server without errors.

mSupply Client software cannot see the mSupply Server?

X

Server is not visible?

e To make it easy for you to connect, mSupply Server
publishes details about available servers on a specific
port. It is quite possible that products such as “Zone

servers is blank.

Alarm” and “Norton Personal Firewall” will block access
to this port and stop discovery of the servers. Contact
your system administrator if the list of available

e Of course, it may be possible that the mSupply Server
service is not running. Check Services to establish that.

e Lastly, the Windows firewall may be blocking the
Server publishing it's presence - see below.

Configuring Windows firewall on server

The Windows firewall may need to be adjusted to allow the Client to receive Server identification.
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To locate an mSupply server on a network mSupply client broadcasts over the
subnet on random UDP ports from 49157 and above. As such inbound UDP ports
from 49157 upwards should be opened on the server firewall. If these UDP ports
are not open on the server then the clients cannot automatically find the server.
However clients can still be manually directed to the server IP address by holding

@ alt when client is opening, and entering the IP address in the network address
field of the custom tab.

The default ports for client/server communication in mSupply server are TCP
19812 & 19813. The server firewall will require inbound TCP ports 19812 and

19813 to be opened (however these ports can be changed in mSupply server if
required).

The firewall on the Client machines could also block access to the server machine. Testing with the
firewalls on the server / client machines temporarily turned off in various combinations will help to
establish whether firewalls are blocking communications.

Manually configuring the mSupply client

Due to firewall or if you connect to mSupply server via a router, then you may need to enter in the IP
address on the mSupply Client custom setting window.

B | Connection to 40 Server 4

w Welcome to 40

Recent Available Custom
Mame and Address of a published 4D Server.
Database Mame mSupply
e accounting

MNetwork Address 1;:.162.3.:5:].

Eic goccownd r'S‘. formpan). ogm

or 192 121,122 123:5858
or: [2001:0db 8 852 30000000082 2=:0570: T324]: 19813

Faorce the update of the local resources

[ Display this dialog at nest startup

Cance

The data base name is always : mSupply

If mSupply server is serving via the default port (19813) then simply enter in the IP address.
Otherwise, see more details on the Custom Tab.
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As part of the installation, a batch file with the name Reset
client temp folder is installed on the desktop. This is for
-~ use if the client begins to behave incorrectly in the future, as
@ described on the 28.01. How to re-set the mSupply client
page. It is not for use during installation so you can safely
ignore it until it is needed in the future. It is safe to move the
batch file to somewhere other than the desktop if needed.

mSupply Server configuration

Register mSupply

The procedure is described earlier in “Preferences” chapter of the mSupply manual. See The Register
button

You will either have to phone or email the information to Sustainable Solutions to obtain a registration
code.

The registration code is keyed to your Organisation name
and the MAC address of the server. Changing either of these

&9 will require a new code, which we shall willingly provide. So,
take care when setting the Organisation Name!

Configure mSupply preferences

Once registered, you may want to systematically to go through the mSupply Preferences and choose

appropriate settings, and particularly setting up the Secondary backups! Start here: Preferences >
General

Turn off web dashboard

If the web dashboard has been set up on the Primary Server, then the dashboard preferences will be
copied to the Satellite site datafile. In most cases, the web dashboard is not being used on the
Satellite site and it is an unnecessary interaction with the scheduler, so may as well be turned off:

Before v4.04:

1. File > Preferences... > Dashboard
2. Untick the 'We use the web dashboard'
3. Click OK
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After v4.04, the dashboard is managed through the Admin page of the navigator:

1. Admin > Dashboard > Export Settings
2. Clear the Postgres Server entries
3. Click OK

4= Cashbcand o[ Eﬂ|
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Papawsard [ i

DlaSaie Ml 2 &6 Do S Tast commecion
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Tabls Export
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L
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1O000x

0 » Expent

Configure secondary backups

You should have already configured the primary backup. We recommend setting up a secondary
backup which will send a backup off-site using a service such as Dropbox. The frequency of this
depends largely on what bandwidth your site can afford. Each backup can easily get to GB sizes...:

e File > Preferences... > Backup 2
o Configure secondary backups

Turn on Synchronisation

When you are finally ready to turn on synchronisation:

e File > Preferences... > Synchronise > Click to un-lock, enter code to edit.
o Set the Sync time interval to 1
o Click OK

&
y’ ! * Your installation of mSupply may have customisations made

specifically for your work scenario. Please contact our
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.. support staff on support@msupply.org.nz to manage these
! ' customisations.

Configure label printer
If you are dispensing, you will need to set up label printer preferences
Graceful shutdown in the event of a power failure

Your mSupply server should be attached to a UPS. The UPS should be fitted with a control cable
(serial, USB or network cable) that allows control software to detect a low power situation and shut
down the server.

In the UPS control software set the shutdown to start at least two minutes before the power will fail.

Set it to run a batch file at that point. The file should contain the single line “net stop Service name”
where the service name is the name displayed in the properties when you double-click the service
name in the services window. In the example below the service name is “4DS mSupply.4DC” (not to
be confused with the display name)

SEMVICE Nname: 405 mSupply.4DC

Digplay name

Drezcription

You may wish to test your typing skills by opening a command prompt:

SWINNTY System32hcmd.exe

Microzoft Windows ZBBA [Uerzion 5.88.21951
CC» Copyright 1985-1999 Microsoft Corp.

C:%>net stop "4DE mSupply._ 4DC'
The 4D Server: mSupply service is stopping...
The 4D Server: mSupply service was stopped successfully.

Conr

Accessing mSupply client on a cloud server

If the mSupply client software is running on a PC, there are a range of applications that can be used
for accessing the cloud hosted mSupply server including Microsoft's own Remote Desktop Connection
software that comes included with Microsoft Windows.
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We recommend TS-Plus, which allows users to access client on the server via their web browser.

Troubleshooting

Permission for backup setting file

Since v17 of 4D (the database engine underlying mSupply), when running mSupply as a Service,
logging on as the Local System Account (LSA, as described below), mSupply MAY no longer have
sufficient permissions to access the folder: C:\Program Files\mSupply\mSupply
Server\Server Database\Preferences\Backup

If this is the case, it will result in the following error:

Rumntime Error

Error when executing the method "* On Backup Shutdown™ at line number

90

L
"_O The document cannot be opened.

Permissions error. Attempt to open locked file for writing. (File: CA\Pragram Files\m3Supply
WnSupphy Server\Server Database\Preferences\BackupiBackup XML}

Details Edit: Trace Abort

Process 9 BackupProcess Save... Copy
Mo Description
54 Permissions error, Attempt to open locked file forwmting, (File: C\Program Files\mSupphtmSupply .
Access denied C:A\Program Files\mSupply@irmSupply Server\Server Database\Preferences\Backup\Back
5 Access is denied.
4 »

If this happens, it needs to be fixed. The Solution is to edit permission of Users to allow Full
control/Modify/Write to the Backup.XML file as shown here:
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